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ZEEE 3. Basic Manual for ArcMap

1. Starting ArcMap

ArcMap lets you explore your geographic data and create maps for display.
1. Click the Start button on the Windows taskbar.

2. Point to Programs. :

3. Point to ArcGIS.

4, Click ArcMap.
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2. Opening a new empty map

The first time you start ArcMap, the Startup dialog box appears. The Startup dialog box
offers you several options for starting your ArcMap session. For this exercise, you want to
open a new empty map document.

1. Click A new empty map

2. Click OK
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3. Adding data in ArcMap

1. Click the Add Data button on the Standard toolbar.

2. Click the Look in dropdown arrow and navigate to the folder that contains the data
source. 7

3. Click the data source.

4. Click Add.

ArcMap creates a new layer on the map that references the data source.
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4. Showing the table of contents
1. Click the View menu on the Standard toolbar.
2. Click Table Of Contents.
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5. Turning a layer on or off

1. In the table of contents, check the box next to the layer’s name. The layer should appear
on your map. If you can’t see the layer, it may be hidden by another layer or display only
at a particular scale.
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6. Zooming in or out

1. Click the Zoom In or Zoom Out button on the Tools toolbar.
2. Move the mouse pointer over the map display and click once to zoom around a point.
Alternatively, click and drag a rectangle defining the area you want to zoom in or out on.
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7. Panning
1. Click the Pan button on the Tools toolbar.

2. Move the mouse pointer over the map display
and click and drag the pointer.

8. Zooming to the full extent of the data

1. Click the Fuli Extent button on the Tools toolbar.

9. Moving back or forward one display

1. Click the Back or Forward Extent buttons
on the Tools toolbar.
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10. Zooming to a specific scale

1. Type the desired scale on the Standarxd toolbar.
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11. Identifying features by pointing at them

1. Click the Identify button on the Tools toolbar.

2. Click the mouse pointer over the map feature you want to identify.

The features in all visible layers under the pointer will be identified.

(Note) This function is useful to know individual information such as transformer,
customer, pole, ete.

ST T slojx
Tl Edit Yom hemn Gectin Tl rdaw Hebp
L = - - B
DSE& B RN A BTN
s I s ~
: ‘ ==
aaj,
ad
— Tz
= .
l-vtﬂ G‘m--ml-w) e
- Curioner Licaign CRANX SIIIID y
-9 Fals  Youm ki
14 T+ i
Shace Poivgon *'\
B ) - .
SCHy 10 = o
HAME Klow
- CATE %
5B Cutorer HATURE  Dirta
MAKE  BHEL
= 6 KADHRELA Y
= - GAPALITY &
= [ KADNP#P %0
N
20 Kporma e
# 1 aoReTme
.
= O KADKLIRWA . 0
=8 Kednkog
e M L =l
Gapiey [Serce] o & T o
G > R D-A-_ﬁmmglgA-a.l-;-
eTTem o T AN B R B nn e
M-t AT Sydvie (A Eathadan - WrcMag B4} - Horovott Word L2l E e w

-5-



ZEZEF 3. Basic Manual for ArcMap

12. Viewing a layer’s attribute table

1. In the table of contents, right-click the layer for which you want to display the attribute
table. : .

2, Click Open Attribute Table.

{(Note) This function is useful to know all information of facilities and customers.
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13. Finding features with particular attributes

1. Click the Find button on the Tools toolbar.

2. Type the string you want to find in the Find text box.

3. Click the In layers dropdown arrow and click the layer you want to search.

4. Search for the string in all fields, in a specific field, or in the primary display field.

5. Click Find.

6. Right-click a row to show context menu.

(Note) This function is useful to know a location of facilities and customers by inputting
name, transformer number, etc.
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14. Setting the units for reporting lengths and displaying coordinates

1. Right-click the data frame in the table of contents and elick Properties.

9. Click the General tab.
3. Chick the Map dropdown arrow and click the appropriate units. The map units option is

only available when your data has no coordinate system information associated with it.
4, Click the Display dropdown arrow and click the appropriate units.
5. Click OK.
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15. Measuring distance

1. Click the Measure button on the Tools toolbar.

2. Use the mouse pointer to draw a line representing the distance you want to measure. The
line can have more than one line segment.

3. Double-click to end the line.

(Note) This function is useful to measure a distance between poles.
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The measuremant displays hars an the status bar.

16. Moving a layer to change its drawing order

1. In the table of contents, click and drag the layer up or down.

A black line indicates where the layer will be placed.

2. Release the mouse pointer to drop the layer in its new position.

(Note) Sometimes you cannot find a layer because another layers are covered with the layer.
In this case, you should move the layer to the top.
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17. Changing the name of a layer

1. In the table of contents, click the layer to select it.

2. Click again over the name.

This will highlight the name and allow you to change it.
3. Type the new name and press enter,
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18. Removing a layer
1. In the table of contents, right-click the layer you want to remove.
2. Click Remove.
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19. Creating a new shapefile

1. Click the ArcCatalog buiton on the Standard toclbar.

2. Select a folder which a new shapefile is stored in the Catalog tree.

3. Click the File menu, point to New, and click Shapefile.

4, Click in the Name text box and type a name for the new shapefile.

5. Click the Feature Type dropdown arrow and click the type of feature the shapefile will
contain.

6. Click Edit to define the shapefile’s coordinate system.

7. In the Spatial Reference Properties dialog box, click Select and choose a predefined
coordinate system. Or click Import and choose the data source whose coordinate system
you want to copy. Or click New and define a new, custom coordinate system.

8. Click OK.

(Note) When you want to add new layer, you have to create new shapfile in advance.
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20. Creating features on layers

An overview of the editing process
The following is a general overview of how to use ArcMap and the Editor toolbar to edit

your data.

1. Start ArcMap.
2. Create a new map or open an existing one.

DT’E@

l Cpen buiton
New map file button
3. Add the data you want to edit to your map.

KT ¢_,

Acd data button

4. Add the Editor toolbar to ArcMap.
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Fditor Toolbar butten

5. Choeose Start Editing fmm- the Editor menu.

[feae~"|

Star Edbien

_Sicp £dbing
SarzCuils
1Arue
Sait,
Diide,
Bk,

N N

< CaopTeralel .
Mere
ey
o btz
Cip...
& Irteniae
22 Yaidats Cebaction, .
N EREla s

Oz, .

6. Create or modify features and /or their attributes.
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7. Choose Stop Editing from the Editor menu and click Yes when prompted to save you

edits.
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21. Opening a Iziyef s attribute table

1. In the table of contents, right-click the layer for which you want to display a table.
2. Click Open Attribute Table.
The layer’s attribute table opens.
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22. Editing text in records

1. If you haver’t started an edit session, click the Editor menu on the Editor toolbar and
click Start Editing.

2. Open the table you want to edit (Refer to 21. Opening a layer’s attribute table)

3. Click the cell containing the attribute value you want to change.

4. Type the values and press Enter.

The table is updated.

(Note) This function is useful to change information, for example, when you replace
facilities such as transformer, meter, etc.
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23. Adding a field to a table

1. Click Options in the table you want to add a field to.

2. Click Add Field.

3. Type the name of the field.

4. Click the Type dropdown arrow and click the field type.

5. Set any other field properties, such as a field alias, as necessary.
6. Click OK.

(Note) This function is useful to add new information fo attribute table.
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24. Deleting a field from a table é

1. In the table window, right-click over the field header of the field you want to delete.
2. Click Delete Field.

3. Click Yes to confirm the deletion.

Deleting a field eannot be undone.
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25. Deleting records

1. If you haven’t started an edit session, click the Editor menu on the Editor toolbar and
click Start Editing.

2. Open the table you want to edit.

3. Select the records you want to delete. Press and hold the Ctrl key while clicking to select
more than one record.

4. Press the Delete key on the keyboard.

Any geographic features associated with the records are also deleted.
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26, Selecting records by attributes

* 1. Click Options in the table you want to query and click Select By Attributes.

2. Click the Method dropdown arrow and click the selection procedure you want to use.

3. Double-click the field from which you want to select.

4. Click the logical operator you wish to use.

5. Scroll to and double-click the value in the Unique sample values list you wish to select.
Alternatively, you can type a value directly into the text box.

6. Click Verify to verify your selection.

7. Chck OK.

Your selection is highlighted in the table.

(Note) This function is useful to find information you want to know.
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27. Changing the display symbol L6 7

1. Click the dot symbol in the table of contents to display the Symbol Selector window.
2. Scroll down until you find the School 1 symbol. Click it.
3. Click OK. The schools are drawn with the new symbol.
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28. Labeling all features in a layer dynamically

1. In the table of contents, right-click the layer you want to label and click Properties.

2. Click the Labels tab.

3. Check Label Features.

4. Click the Label Field dropdown arrow and click the field you want to use as a label.

5. Click OK.

8. In the table of contents, right-click the layer and check Label Features to turn dynamic
labels on. Uncheck Label Features to turn them off,
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29. Displaying features by category

1. In the table of contents, right-click the layer you want to draw showing unigue values
and click Properties.

2. Click the Symbology tab.

3. Click Categories.

4. Click the Value Field dropdown arrow and click the field that contains the values you
want to map.

5. Click the Color Scheme dropdown arrow and click a color scheme.

6. Click Add All Values.

7. If you want to have more descriptive labels, click a label in the Label column and type a
new one.

8. Click OK.
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30. Creating and accessing hyperlink

1. Click the Identify Features button on the Tools toolbar.

2. Click a feature you want to create hyperlink.

3. In the Identify Results window, right-click the feature you want to set a hyperlink for
and click Add Hyperlink.

4. To link to a document, click Link to a Document.

5. Choose a document on your holder.

6. Click OK.

7. Click the Hyperlink tool on the Tools toolbar and click a feature.

(Note) This function is useful to know a situation of facilities' installation.
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31. Creating a graph and adding it to a layout

. Click the Tools menu, point to Graphs, and click Create.

. Click the Graph. type and subtype you want.

. Click Next.

. Click the dropdown arrow and click the layer or table you want to graph.
. Check to graph only the selected features or records.

. Check the fields you want to graph.

. Click an option to graph data series using Records or Fields.

. Click Next. u

. Type a title for the graph.

10.Check Label X Axis With, then click the dropdown arrow and click a field.
11. Check Show Legend.

12.Check Show Graph on Layout.

You can add the graph to the layout later if necessary.

13.Click Finish.
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32. Saving a map as a new map

1. Click the File menu and click Save As.
2. Navigate to the location to save the map document.
3. Type a file name.

4. Click the Save as type dropdown arrow and click ArcMap Documents.
5. Click Save.
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33. Adding a table with x,y coordinates

1. Click the Tools menu on the Standard toolbar and click Add XY Data.

2. Click the table dropdown arrow and click a table that contains x,y coordinate data.

If the table is not on the map, click the browse button to access it from disk. File format of
table should be dbf file format. Please refer to next item 34 if you do not know how to
make dbf file.

3. Click the X Field dropdown arrow and click the field containing x-coordinate values.

4, Click the Y Field dropdown arrow and click the field containing y-coordinate values.

5. Click Edit to define the coordinate system and units represented in the x and y fields.

6. Click OK.

{Note) This function is useful to display locations for facilities when you do not have enough
landmarks on your map. :

o ko Add XY Dalo ]

oled Whdow Hepr _ 4 table containing X and ¥ cacrdiae data can be added to the

A 27 Ediar Foaba map as a laper
- Graphe r B Checo= a tatle lram tae map ot brows= b anotaer 1ztie!
r z:zﬂs : : O —I[ s =1 &3

v AddsiData. ' r Specty the felds for the X and ¥ coardinatas ——————

¥ SddRoute Eveits.... X Fisld: ¥ Field:
- bR Auiler o B —[Li'_]\'[i = IL:T = 0

~ Spahid Ra!éwnce
Deseiption
Unknown Cootdinale $yztem -“_l

N o

™ Skaw Qetaie Edit. | e
——d |

-21-



ZEHEL 3. Basic Manual for ArcMap

34. Creéting DBF file for x,y coordinates

You can create DBF file using Microfoft Excel.
1. Input longitude and latitude data that were obtained by GPS to Excel file.

--ur-- S —— PR ey e T T T e
."L:‘Hn::.{ ar‘am.\a-e L NSl EE S I Rk T MIFdrsy -2 e D0 ﬁ@’ﬁ €l A Tl o0 %
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1] Longitude - Latitude
2 degree minutes seconds degree minutes seconds -
3 78 3 55.1 17 35 241
4 . 78 3 54.4 17 35 23.5
5 78 3 52.7 17 35 225
6 78 3 50.5 17 35 21.2
7 78 3 49.9 17 35 19.5
8 78 3 49.6 17 35 17.9
9 78 3 493 17 35 16.4
10 78 3 52 17 35 16.9
1 78 3 47.2 17 35 15.9
12 78 3 442 17 35 15
13 78 3 425 17 35 14.3
14 78 3 436 17 35 12.2
15 78 3 43.1 35 10.3 .
CRFNAUSEIFL Py Y L] | wr
;—J ATER" Lwhwew WMM =@ E‘I 124

2. You have to convert all data from 60 system to decimal system.
Equation = (seconds/60 + minutes)/60 + degree

T A R =
AlB £ Yew et Fyod Tk Qi Wrde teb

voxk - P H € L
Lo » X E =(CUE0+ERE0HAT -
A c D E F 6 | H | 5=
1 Longitude Latituds o
2 degree minutes seconds degrea  minutes  seconds
(37 3 s 17 3% 24.1[=(C3B0+BY60+AY <
4 78 3 544 17 35 235 -
5 78 3 52.7 17 35 225
6 78 3 50.5 17 35 21.2
7 78 3 49.9 17 35 19.5
8 78 3 49.6 17 35 17.2
9 78 3 49.3 17 35 16.4
10 78 3 52 17 s 16.8
11 78 3 47.2 17 35 15.9
12 78 3 44.2 17 35 15
13 78 3 42.5 17 35 14.3
14 78 3 43.6 17 35 12.2
15 78 3 43.1 17 35 10.3
18 78 3 431 17 35 8.3
17 78 3 42.8 17 35 85
18 78 3 42.3 17 35 34
19 78 3 41.2 17 35 14
20 78 3 414 17 34 59.8
21 78 3 41.2 17 34 58.7
T w\hentt {7t e £ " “n “ o [~ - ur
;:'-l 2 FEn A" Avifawit) [T Wrosett Evcnl - 0BF1 18} 000 -Miromeh Word s 2F o
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ZE ¥ 3. Basic Manual for ArcMap

3. Select data that you converted.
4. Click copy.

e ——— L

nz;i“ Unda Tk <(CHDHNSOHAT G k2 Aon R EL Ay, T MEPTMar  em - s AR €S MA- B oy = ¥
N o c D E F 6 | H | *#
1|3 T o Lafitude

2| ez seconds degree minutes seconds Longitude Latilude

(3] . 55.1 17 35 24.1( 78.06531 17.59003| -

4 ’ 54.4 17 35 235 78.06511 17.58986

| 5| oo 52.7 17 35 225| 78.06464 17.58958

Bl - 50.5 17 35 21| 78.06403 17.58922

A - 49.9 17 35 19.5| 78.06386 17.58875

[ ] 49.6 17 35 17.9] 78.06378 17.58831

] 78 3 493 17 35 16.4] 78.06369 17.58789

10 78 3 52 17 35 - 16.9| 78.06444 17.68803

11 78 3 47.2 17 35 15.9| 78.06311 17.58775

12 78 3 44.2 17 35 15| 78.06228 17.5875

13 78 3 42.5 17 35 14.3| 78.06181 17.58731

14 78 3 43.6 17 35 12.2} 78.06211 17.58672

15 78 3 43.1 17 35 10.3| 78.06197 17.68619

16 78 3 43.1 17 35 8.3} 78.06197 17.68564
7). 78 3 428 17 35 8.5| 78.06189 17.58569

18 78 3 423 17 35 3.4| 78.06175 17.58428

19 3 41.2 17 35 14| 78.06144 17.58372 .

a4 b HASheet [ ez { ees £ fer ! W

F EC TR A (L) | 2)Docurent - smmet e J08F1 I L I e e ;ﬂ g

5. Open new file.

e e T R, P ' =
) E ven joet Fowd Iob Dot Wriow e P
3 - SO 3ef v LR ) s TMIPLLaE -b - Br U R €W PepA. T O T

[ wen 3 c D E F 6 [ H [ =
e sk :jitude Latitude

——ueyrew——wmiltes  seconds  degree  minutes  seconds Longitude Latitude

| 3 | 78 3 55.1 17 35 24.1( 78.06531 17.59003 -
| 4 | 78 3 54.4 17 35 23.5} 78.06511 17.58986

| 5 | 78 3 52.7 17 35 22.5} 78.06464 17.58958

| 6 | 73 3 50.5 17 35 21.2] 78.06403 17.58922

7 78 3 49.9 17 35 19.5| 78.06386 17.58875
I 78 3 49.6 17 35 17.9| 78.06378 17.58831

g 78 3 49.3 17 35 16.4| 78.06369 17.58789
E 78 3 52 17 35 16.9| 78.06444 17.58803

| 11 | 78 3 41z 7 35 15.9| 78.06311 17.58775
112 | 78 3 44.2 17 35 15| 78.06228 17.58756
|13 | 78 3 42.8 17 35 14.3| 78.06181 17.58731
|14 ) 78 3 43.6 17 35 12.2] 78.06211 17.58672

1 16 | 78 3 43.1 17 35 10.3] 78.06197 17.58619
iﬁ_ 78 3 43.1 17 35 8.3] 78.06197 17.58564

| 17 | 73 3 42.8 17 35 8.5] 78.06189 17.58569
18 | 78 3 42.3 17 35 3.4| 78.06175 17.58428

19 78 3 .2 17 35 1.4| 78.06144 17583727 .
aa e whenty { ez L v / . [} ! i
;é 2IE AT LMkl | M)Bccusarl -Moromonward +106F1 i re— g “:;;'.l UM
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ZEER 3. Basic Manual for ArcMap

6. Click Paste Special.

H) P [l pem bwet Fomk Dods Dols dndom Heb - ' -8 x
o ger e @t v B HH R T e cl- B Y EEE AWE A T8 2
A3 e Qubd -

B B B Su— | c D E F G H i £
1] o .
2 e

Borvs v Copy St
% Bed.

ame
Rplace.. s
[ S—— E———

OO0 ~mag W

4 & 3 i\ Ehoctl { Seez [ 3wty / : : Isl | 'IF
Anwty wH
Avm] & TR LXRerk | B Cocumeet - Wioowh Word < 108F1 j ajper2 By & QD 12%

7. Click value.
8. Click OK.

VoA mEet e AE-EHALG M o S e B P U EES @A A T oo F 0 T

B C D E F G H | =

x|

o Eomies 7 Wt agosgh borders

E
10 " Pormals  Foguies and murdw formaty
© Commants 7 ¥ales are rosrber formets

12 < * okt

23 -

W u b K\Shoett { Shet2 {Sted [/ 14] t 'lI:
‘Swlect derbration and prevs. ENTES or choosa Facte ]

Bowt| 22N Mook | L) ocumertt -Mimmn W] = J0BF1 | <josrz i =1eoekt d: BE em
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BEEER 3. Basic Manual for ArcMap

9. Select data.
10. Click Cell.

Ao Bk Yew ot
"

Pridan

i
§
i
_i

Qe

=

LA
78.0655"

78.06454
78.06403
78.06386
78.06378
78.06369
78.06444
78.08311
78.06228
78.06181
78.06211
78.06197
78.08197
78.06189°
78.06175
78.06144
78.0815
78.06144
78.06161
78.06169
78.06131
78.06085

‘
e D N e D N e

78.0651T—TT-co9eo

1yef

Aol
orRior oI,

T Ea T T aald

: g x
R ECSIHT LT T A el - B I ERE CES MeA Fejs O T

C D E F G H T

- -

1758050
17.58922
17.58875
17.56831
17.58789
17.58603
17.58775

17.5815
17.58734
17.58672
17.58619
17.58564
17.58569
17.58428,
17.58372
17.58328
17.56207
17.58239
17.568197
17.58461
17.58133ky

bt £ itz { et

‘Schuct dhstinalic’s wd pres: INTIR o dhotse Pte

i ce DA _Lrensaw

L}

i
-
| ) Dnarts sl Wind 40081 | a1perz | Siwent L L

11. Click Number

12. Click Custom
13. Click 0.00

r::_‘,ﬂ
it

P

]

s ARy

H

AMB-T ae A -l Qe T wd W BSY FER LW DA T 04D
- e 78 CESISSESSEEE

Vowt Fret Ik Dts elw b R

B

78.06531
78.06511
78.06464
76.06403
78.06386
78.06378
78.06369
78.06444
78,0631
78.06228
78.06181
78.06211
78.08197
78.06197
78.06189
78.06175
78.06144
78.0615
20| 78.06144
21] 78.06161
33| 78.06169
(23] 78.06131

slalz [ =[slele]vjo]o] sl -

S
[z

78.06088
W43 W\ Shret) { Swez { Soees
Nandy
Avet| @ T2 _ninmrl

17.59003
17.58986
17.58958
17.58922
17.58875
17.58831
17.58788
17.58803
17.58775

17.5875
17.58731
17.58672
17.58619
17.56564
17.58569,
17.58428
17.58372
17.58328
17.58297
17.58239
17.58197
17.58161
1;(.53133

c D E F G H 1 =

[FowscCate 0SS 1ix
el i | mcrauct | ot | Borde | patans | motaten |
Categprr: Sargle

T
po
A
]

o
0 e e
Hatet o] 2

ot Lo, ramy

o) e |

| #JOocnurer Merack Word 4061 | Joo2 BTy LN W
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BEEEL 3. Basic Manual for ArcMap

14. Add 0 down to 5th or 6th places of decimals.

15. Click OK.

R

S

FuUaS8G T

Hriad

~I6 . B Ff EUE TR Mo P ouinx

ELL]

- 8%
g 3

c

78.06531
78.06511
78.06464
78.06403
78.06386
78.08378
78.06369
78.06444
78.06311
78.06228
76.06181
78.06211
78.06197
78.06197
78.06189
78.06175
76.06144

78.0615
78.06144
11 78.06161
78.06169
78.06131
78.08086

N\Sheet) { Fuatz f shoats [/

17.58958
17.58922
17.58875
17.58831
17.58789
17.58803
17.58775

17.5875
17.58731
17.58672
17.58619
17.58564
17.58569
17.58428
17.58372
17.58328
17.58207
17.58239
17.58197
17.581614
17.58133

LR R I L]

D E F

hiLi
tembur | igreese | ork | ferdar | et | frotorsen §
Sw--l‘ M504 V
Tyon:

G

s sn0m
2,590, 5t0.800)
.00 0, 09

. =
|

g tha b Frmat o,k om o e i codt R

oo |

| B)Dccmctt -Nomctword 210871

| xloer2

Al bk fes yowt fome Dk Dde weda b

SEHaY SRV ARET o

on2 - &

arx-EHIladn 4

H ] CE

e
et
83 1mm

LY

6 s B I WA EERT MM ¥y 0 ¥

78.00
78.06511
78.06464
78.06403
78.06386
78.06378
| 78.06369
78.06444
10 78.06311
11 78.06228
12 78.06181
13 78.06211
14 78.06197
15 78.06197
16 78.06189

" :‘»7‘\,&‘7‘9& 5:2‘/-’:

SOONDO B RN

L
Ml BTG MR | B}toomerd - Woesek Wiod] 30051

.0%003

'_;_]

c

17.58986 -

17.58958
17.68922
17.58875
17.58831
17.58789
17.58803
17.58775
17.58750
17.58731
17.58672
17.58619
17.58564
17.58569

417 ZOANO

| 2oem
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SEZEF 3. Basic Manual for ArcMap

17. Click a carsor on any data.

Witk Gh ver put et Tk Ges Mo b 3 T ek
huﬂr’;c&’&l&h"& ctoe - AT-RHUNECT T o W - BJ U FZE EUL AT E 0
£ THOBdpssqasials

A B C D E F =
1 LONG  LAT :
2 78.06531 17.59003
'3 78.06511 17.58986
4 78.06464 17.58958
5 78.06403 17.58922
6 78.06386 17.58875
7 78.06378 17.58831

88" 17.58789
[78.06444] ¥.58803
10°~78-06341 17 58775

11 78.06228 17.58750
12 78.06181 17.58731
13 78.06211 17.58672
14 78.06197 17.58619
15 78.06197 17.58564
16 78.06189 17.58569

47\1'“'7‘0 f)ﬂ‘il'fl: A7 E0AN0

ol ! e

L
as-- 85 Aidrik) 2] Mowh i S {081 | ajoer [T - LY.L R

18. Chick Save as.

Jmlww—r—thmmybu
P ) M0 T ol . AT D Y o 10 .M LD RED LUS NA B D 7

W“]. =
‘ o B C D E F =

e LAT

2 78.06531 17.59003
3 78.06511 17.58986
4 78.06464 17.58958
5

~ 78.06403 17.58922
6 7806386 17.58875
7 78.06378 17.58831
8 78.06369 17.58789
9 [78.06444] 17.58803
10 78.06311 17.58775
11 78.06228 17.58750
12 78.06181 17.58731
13 78.06211 17.58672
14 78.06197 17.58619
15 78.06197 17.58564
16 78.06189 17.58569

47 70 Qﬂ‘i‘ﬁ': 47 ZoANC . ; T

o
mu LR R T | 30t - Moo 1 Y081 faJosr2 =lwabt g ST e

-27 -



£EZEH 3. Basic Manual for AccMap

19. Input name in File

Name.

20. Select DBF 4 (dBASE IV).

21 Save
LN T T aleix|
Al Ge Bk e Jeset Fmat Joub Gua ke Heb . - o x
miglg?é%;m;cm R TR WL . g BrU FEREH EBS HoA- T ogr B
A B c E F =

1 LONG  LAT

2 78.06531 17.59003 )
3 78.06511 17.58986

4 78.06464 1jmTwemmms e

5 78.06403 17 , bF=

6 78.06386 17— smen

7 78.06378 17| S

8 78.06369 17 2l g5

9 [78.06444] 17 .,

10 78.06311 J

11 78.06228 o

12 78.06181 :

13 78.06211 17.58672

14  78.06197 17.58619

15 78.06197 17.58564

16 78.06189 17.58569
":l.?\mz(gw ,e;i/'ﬂ: 417 E0ANO ‘”'_
?ﬁl STIH" A0 | MDonment Mt uiod, 53000 | 3 Joer2 9

Microfoft Excel asks you some messages (warning). You can click OK.
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JICA India Office

Mr. T. Take
Mr. T. Matsumoto

APTRANSCO

M~ T. R, C. Bose
Mr. D. Ramakrishna Rao

Mr. Ramakosteswara Rao

Mr. A.D.V. Sai Baba Rao

APCPDCL

Mr. S. Suryaprakasa Rao
M. G. Purandar Rao
Mr. L. Radha Krishna
Mr. C. Srinivasa Rao
Mr. G. Sudarshan

Mr. J. Sreenivasa Reddy
Mr. Mohad Mazhar Ali
Mr. V. Gandhi Das

Mr., P. Sadanandam

Mr. Manohar

Mr. Peachushetty

Mr. Kondal Reddy

Mr. V. Sudahakar

Mr. Srinivasa Chary
Mr. C. P. Bapulu

Mr. Venkalayah

Mr. K. Raghuma Reddy
Mr. 8. Chittaranjan

Mr. N. L. Prabhaker

A RET YRI5 4 v P a MR BERGETERAL mkE
551 KHE
Embassy of Japan
H. E. K. Kodama Minister
Mr. H. Kobayashi Counsellor

Deputy Resident Representative

Assistant Resident Representative

Director, Projects
CE, DFID & APL
DE, DFID

Superintending Engineer

Director, Commercial

DE, Projects (SE, O & M)
DE, Operation

Director (Finance)

General Manager

SE, RR(S)

AAE, Tech.RR(S)

SE, RR(N)

SE, Sangareddy, Operation
AEFE, Commercial, Sangareddy
LT Meter, Sangareddy
DE/SCADA

ADE/Project

ADE/SCADA
S.E./OP/CENTRAL
D.E/Meters/Sangareddy
D.E/Operation/Saroornagar
A.D.E/Operation/Saroornagar
A.D . E/Gaganpahad

-1-
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Mr. Ch, Chakrapari A.D.E/SCADA Project
Mr. S. Srikanth AE/Tbrahimpatnam
Other

Dr. M. V. Krishna Rag Director GECE Private Limited

Mr. S. R. Vijayan Mnager-Engineering Network/Management System ABB(Bangalore)
Mz, Peter Smith MSec, C Eng DFID

Ms. Bhavna Bhatia Senior Energy Economist WB

Dr. M. V. Krishna Rao Director, Global Energy Consulting Engineers
Mr. K. Satheesh Kumar Director, Map World Technologies Ltd.

Mr. Maj. Shiva Kiran Editorial Associate, GIS India

Mr. Ravi Kanth Reddy Secure Meter Limited
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1

2 KR

JICA India Office

=7

Mr. T. Sakai
Mr. T, Matsumoto

APTRANSCO

Mr. J. V. Pandurangam
Mr. D. Ramakrishna Rao
Mr. Ramakoteswara Rao
Ms. D.Jayshree

APCPDCL

Mr. Suyaprakasa Rao
Mr. G. Purandar Rao
Mr. Ramamohan Meda
MTr. Srinivasa Chary
Mr. Ch. Chakrapari
Mr. D. Sudhama

Mr. NI Prabhakar

Mr. X Rajendar

Ms. Jyothi Rani

Mr. Chiranjeevi Rao
Mz K, Rajeswar

Mr, Hemachandler

Mr. D. L. Prabhakar
Mr. Y, Markandaiah
Mr. K. Raghuma Reddy
Mr. G Amuruthaiah
Mr. M. Sudhakar Reddy
Mr. S. Ravi Kumar

Mr. N. Sudbakar

Mr. P. Jagathpal Reddy
Mr. K. Venkat Reddy
Mr. Md. Masood

Mr. K. Bagaiah

Resident Representative

Agssistant Resident Representative

Director/Project
CE/DFID&APL
DE/DFID
AE/OPN/APTRANSCO

Director/Commercial & Project
DE/Project

DE/SCADA

ADE/SCADA

ADE/SCADA Project
Sub-Engineer/Hyath nagar 85
ADE/OP/Kattedan SS
ADE/OP/Kattedan SS
AE/Telecom

AE/Telecom

DE, Technical, RR(S)

ADE, Commercial, RR(S)
ADE, Gaganpahad, RR(S)

DE, Operation, Rajendranagar, RR(S)
DE, Operation. Sarcomagar, RR(S)
DE, Technical , RR(N)

DE, Technical , RR(N)

ADE, Cpmmercial, RR{N)
AEE, Technical, RR(N)

SE, Operation, Sangareddy
DE, Technical, Sangareddy
AEE, Malkapur, Sangareddy
AE, Commercial, Sangareddy
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Mr. Krishna Murthy ADE, Qperation, Sadasivapet, Sangareddy

Mr. K. Raju AF, Technical, Sangareddy

Mr. L. Radha Krishna DE, Operation

Mr, I. Sreenivasa Reddy SE, RR(S)

Mr. Mohad Mazhar Ali AAE, Tech.RR(S)

Mr. Manohar AE, Commercial, Sangareddy

Mr. K. Vekata Narayana Chief General Manager/APCPDCL

Mr. Venkalayah D.E/Meter§/Sangareddy

Mr. Syod Masood Addi. Assit. Engineer/OP/Condapur

Mz P.V.L. Narayana Rao ERO, Saroornagar

Mr. K. Bagaind AE/Commercial, Sanga Reddy

Mr. LN. Plabhakee ADE/Qperation, Gaganpahad (Kattedan)
Other

Mr. S.R.Vijayan Mnager-Engineering Network/Management System ABB(Bangalore)

Mr. K. Satheesh Kumar Director, Map World Technologies Ltd.

Mr. Maj. Shiva Kiran Editorial Associate, GIS India
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Embassy of Japan

V7

Mr. H. Kobayashi
Mr. M. Sakuramachi

JICA India Office

Mr. T. Sakai
Mr. T. Matsumoto

APTRANSCO

Mr. J. V. Pandurangam
Mr. D. Ramakrishna Rao
Mr. Ramakoteswara Rao
Mr. G. A. Manikya Prabhu
Mr. V. D. B, Srinivasa Rao
Mr. K. Laxmi Narsaiah
Mr.Chandra Sekhar

APCPDCL

Mr. Dimesh Kumar

Mr. Ganesh Rao

Mr. A. Raghavendra Rao
Mr. G. Purandar Rao
Mr. J. Sreenivas Reddy
Mr. P. Jagathpal Reddy
Mr. Y. Markandaiah
Mr. K. Raghuma Reddy
Mr. Ch. Ashok Reddy
Mr. B. Nagaraju

Mr. Venkalayah

Mr. S. Chittarapjan

Mr. N. L. Prabhakar
Mr. Bagaiah

Mr. K. Raju

Mr. Syod Masood

Counsellor

First Secretary (Commercial)

Resident Representative

Assistant Resident Representative

Director/Project
CE/DFID&APL
DE/DFID

S.E, CTI

ADE, CTI

S.AQ,CTI

AD.E, Computer center

Chaiman & Managing Director/APCPDCL
PS to CMD/APCPDCL

Director / Operation/APCPDCL
S.E/O&M/Corporate Office
S.E/Ranga Reddy (South)
S.E/Operation/Medak
D.E/Operation/Rajendranagar
D.E/Qperation/Saroornagar
D.E/Operation/Sangareddy
D.E/Meter/APCPDCL
D.E/Meters/Sangareddy
A.D.E/Operation/Saroornagar
A.D.E/Gaganpahad

A E/Commecial/Sangareddy

A E/Tech/Comm/Sangareddy

Addi. Assit. Engineer/OP/Condapur

-5.



fT8 1 m#FEU A b

Mr. S. Venkat Krishna
Mr, S. Srikanth

Mr. K. A. N. Rao

Mr. M. Bhaskar Reddy
Mr. N. Nagaraj

Mr. B. Karunakara Rao
Mr. L. Radha Krishna
Mr. Mohad Mazhar Ali
Mr. K. Rajeswar

Mr. X. Rajender

Mr. M. Sudhakar Reddy
Mr. S. Ravi Kumar

Mr. N. Sudhakar

Mr. P. Jagathpal Reddy
Mr. K. Vankat Reddy
Mr. Md. Masood

Mr. K. Bagaiah

Mr. Krishna Murthy
Mr. G. Gnana Shekav
Mr. G. Manohar

Mr. Venkatech

M. L.N. Plabhakee
Mr. Praveen Kumar
Mz, Nazar Nawaz

Mr. G. Jayaprakash Das
Mr. G. Ravinder

Mr. P. Srinivasulu

Mr. T. Vishnu Vardhan Reddy

Mr. D. Nagender Naik

Mr. C. Rama Mohan Rao

Mr. Subba Rao

Mr, L. V. Raghava Rao
Mr. X. N. Rao

Mr. Ramamohan Meda
Mr. Radha Krishna
Mr. Raghma Reddy
Mr. A. Manohan

Asst. to ADE/Gaganpahad

Asst. Engineer/Saroornagar

Sub Engineer/Sangareddy

Secure meter limited

SE, RR(N)

Sub-E, Div, Saroornagar, RR(S)

DE, Operation

AAE, Tech.RR(S)

DE, Technical, RR(S)

AE, Operation, Xattedan, RR(S)

DE, Technical , RR(N)

ADE, Cpmmercial, RR(N)

AEFE, Technical, RR(N)

SE, Operation, Sangareddy

DE, Technical, Sangareddy

AEE, Malkapur, Sangareddy

AE, Commercial, Sangareddy

ADE, Operation, Sadasivapet, Sangareddy
Sub-Engineer, Sanga Reddy (Malkapur)
AE/Commercial, Sanga Reddy (Malkapur)
Sanga Reddy (Malkapur)
ADE/Operation, Gaganpahad (Kattedan)
Gaganpahad (Kattedan)

Saroornagar (Kothapet)

A.E (Tech), SCADA Center

Sub. Engineer, SCADA Center

A.AE, SCADA Center

ADE, LSTC

AELSTC

Director, HRD & P&MM

C.E, Operation

PO

AS

D.E, SCADA Project

D.E, Energy Audit

D.E

AE
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Other
Mr. S.R.Vijayan
Mr. B.S. Varma
Mr. K. Satheesh Kumar
Mr. B. 8. Varma
Mr. M. V. S. Birinchi
Mr. K. Satheesh Kumar

Mnager-Engineering Network/Management System ABB(Bangalore)
Director GECE
Director, Map World Technologies Ltd.
Director, Global Energy Consulting Engineers
Advisor (Power & Energy), ESCI
Director, Map World
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Embassy of Japan
Mr. H. Kobayashi

JICA
Mr. T. Sakai
Mr. K. Ito

APTRANSCO
Mr. . V. Pandurangam
Mr. Satyanarayana Murthy
Mr. Ramakosteswara Rao
M. Sundaraiah
M. S. Sivakumar Varma
Ms. Anurga
Mr. Peshi
Mr. Chandra Sekhar
Mr. A. V. Seshaiah
Mr. G. A. Manikya Prabhu
Mr. V. D. B. Srinivasa Rao

APCPDCL
Mr. Dimesh Kumar
Mr, G, Purandar Rao
Mr. Ramamohan Meda
Mr. Subba Rao
Mr. Srinivasa Chary
Mz, Ch. Chakrapari
Mr. Ragendar Singh
Mr. Upender Reddy

Mr. V. Bangalaiah

Mr. S. Srikanth

Mr, P, Veereshalinggam
Mr. K. Rajeswar
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Counsellor

Resident Representative

Deputy Resident Representative

Director, Projects
C.E/DFID&APL
DE, DFID
CE/Telecom
ADE/Telecom
ADE/Telecom
Director/HRD, PLG&RD
ADE
AE/DFID&APL
S.E/CT1
AD.E/CTI

Chaiman & Managing Director/APCPDCL

SE/0&M
SE/Assesments
DE/SCADA
ADE/SCADA
ADE/SCADA Project
AFE/CBD/Asif Nagar §S
Vanastlipuram S8

SE, RR(S)

AE, Saroornagar, RR(S)

Sub-E, Sadasivepet, Sangareddy
DE, Technical, RR(S)
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Mr. Hemachandler

Mr. D, L. Prabhakar
Mr. K. Rajender

Mr. Y. Markandaiah
Mr. X. Raghuma Reddy
Mr, G. Amuruthaiah
Mr. M. Sudhakar Reddy
Mr. 8. Ravi Kumar

Mr. N. Sudhakar

Mr. P. Jagathpal Reddy
Mr. K. Vankat Reddy
Mr. Md. Masoad

Mzr. K. Bagaiah

Mr. Krishna Murthy
Mr. K. Raju

Mr. Ch. Ashok Reddy
Mr. S. Chittaranjan
Mr. N, L. Prabhakar
Mr. S. Srikanth

Mr. K. A. N. Rao

Mr. M. Hanumat Sai
Mr. S. Venkat Krishna
Mr. Venkalayah

Mr. Bagaiah

Mr. Venkatech

Mr. L.N. Plabhakee
Mr. L. Radha Krishna
Mr. P. Jagathpal Reddy
Mr. Er. S. Sreckanth

Mr. T. Vishnu Vardhan Reddy

Mr. E. Jagan Mohan
Mr. L. Radha Krishna
Mr. Veereshalingan
Mr. Y. K. Reddy

Mr. N. 8. R. Murthy
Mr. K. Narashinga Rao
Mr. D, Nagender Naik
Mi. Manchar

ADE, Commercial, RR(S)

ADE, Gaganpahad, RR(S)

AE, Operation, Kattedan, RR(S)
DE, Operation, Rajendranagar, RR(S)
DE, Operation. Saroornagar, RR(S)
DE, Technical , RR(N)

DE, Technical , RR(N)

ADE, Cpmmercial, RR{N)

AEE, Technical, RR(N)

SE, Operation, Sangareddy

DE, Technical, Sangareddy

AEE, Malkapur, Sangareddy

AE, Commercial, Sangareddy

ADE, Operation, Sadasivapet, Sangareddy
AE, Technical, Sangareddy
D.E/Operation/Sangareddy
A.D.IE/Operation/Sarcornagar

A D.EfGaganpahad

Asst. Engineer/Saroomagar

Sub Engineer/Sangareddy

Computer in charge at ERO/peration/Saroornagar
Asst. to ADE/Gaganpahad
D.E/Meters/Sangareddy

A E/Commecial/Sangareddy
Gaganpahad (Kattedan)
ADE/Operation, Gaganpahad (Kattedan)
DE/EA

S.E/Operation/Medak
A.AE/Qperation/Sarocornagar
ADE/LSTC

S.E/Master Plan Circle

D.E, Energy Audit
Sub-engineer/Sadasiypet

D.E/Master Plan

A.D.E/Master Plan

A.D.E/Master Plan

A.E/ASTC

AE

-9.
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Mr. K. Subhas Chandra Bose D.E/Construction/City North
Mr. L. Laxminarayana A.D.E/construction/City North
Other
Mr. S, R, Vijayan Mnager-Engineering Network/Management System ABB(Bangalore)
Mr. Pankaj Prandhan Reliance
Mr. Pavan Kumar Reliance
Mr. K. Satheesh Kumar Director, Map World Technologies Ltd.
CIRE
Dr. P. S. Rao, Additional Director/CIRE
Dr. M. Y. Reddy CIRE
Dr. R. Mohamed Nafi Deputy Director/CIRE
Mr. S. V. Murty Program Coordinator/The Institute of Indian Foundrymen,
Research & Development Center, Technology Upgradation
Programme(A.P.)
ESCI
Mr. C. §. Sastry Deputy Director/ESCI
D, §. Nagabhushana Rao Director/ESCL
Mr. J. Balakrishna Rao Senior Faculty/Power & Energy Division/ESCI
(Formerly C.E/APTRANSCO)
Dr. C. Radhakrishna Director & Professor of Electrical Engg,

/UGC-Academic Staff College)
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Embassy of Japan
Mr. H. Kobayashi

JICA India Office
Mr. T. Sakai
Mr. T. Matsumoto
Mr. K. Tto

APTRANSCO
Mr. J. V. Pandurangam
Mr. G. Kasava Rao
Mr. Satyanarayana Murthy
Mr. Ramakosteswara Rao
Mr. R. Ashokachary
Mr. Chandra Sekhar
Mr. A. Seshaiah
Mpr. S. Subramanyam
Mr. T. S. Haranadha Rao
Mr. K. Vidyadhari
Mr. O. Haripasad

APCPDCL
Mr. Dimesh Kumar
M. G. Purandar Rao
Mr. Ramamohan Meda
Mr. U. Vidyasagar
Mr. G. Vinay Kumar
Mr. G. Pedda Bapulu
Mr, L. Radha Krishna
Mr. B. Krishna Murthy
Mr. K. Rajeswar
Mr. Y. Markandajah
Mr, D. L. Prabhakar
Mr. K. Rajendar

55 5 KBMAE

Counsellor

Resident Representative
Assistant Resident Representative

Deputy Resident Representative

Director/Projects Construction
Director/Transmission & Grid Operation
C.E/DFID&APL

DE, DFID

DE/OECF

ADE

AE

DE/APL

Chaiman & Managing Director/APCPDCL
SE/O&M

SE/Assesments

ADE/T to CMD
Director/Operation
CGM/Operation

DE/Operation
SE/Operation/Ranga Reddy South
DE

DE/Qperation/Rajendranagar
ADE/Gaganpahad
AF/Operation/Kattedan

-11-
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Mr. K. Raghuma Reddy
Mr. Chittaranjan

Mzr. Srikanth

Mr. S. Sitaram Babu
Mr. P. Jagathpal Reddy
Mr. Amarnath

Mr. Bagaiah

Mr. Syed Masood

Mr, R. Krishna Murthy
Mr. N. S. R. Murthy

Other
Dr. P. S. Rao
Mr. G Shanker

SE/Operation/Saroomagar
ADE/Operation/Saroornagar
AAEFE/Operation/Saroornagar
AGM/IT
SE/Operation/Medak
AE/Technical/Sanga Reddy
AX/Commercial/Sanga Reddy
AAE

ADE/Operation

ADE

Additional Director/CIRE
Faculty Member/CIRE
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Minutes of Meeting
for

The Development Study on the Improvement of Power Distribution System of Andhra
Predesh in India

Agreed Upon Between
Japan International Cooperation Agency (JICA) Study Team
and
The Transmission Corporation of Andhra Pradesh Limited

Hyderabad, 11 February 2003

SEH 44 Bl

Mr. Toshifumi Sakai J. V, Pandurangam

Resident Representative of JICA Director (Projects)

India Office Transmission Corporation of
Andhra Pradesh Limited
(APTRANSCO)

/(/‘j_\/‘/L/ Ui /2403

S. Surya Prakasa Reo

Director (Commercial & Projects)
Central Power Distribution
Company of Andhra Pradesh
Limited (APCPDCL)
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The Study Team (hereinafier referred to as "the JICA Team") , on "The Developmemt
Study on the Improvement of Power Distribution System of Andhra Pradesh in India
(hereinafter referred to as "the Study"), organized by the Japan International
Cooperation Agency (hereinafier referred to as "JICA"), represented by Mr. Toshifimi
Sakai, had a series of discusstons regarding the implementation plan of the Scope of
Work (hercinafier referred to as “S/W™) signed on 29 May 2002 with the officiais of
Transmssion Corporation of Andhra Pradesh Limited (hercinafler referred to as
“APTRANSCO™) and Central Power Distribution Company of Andhra Pradesh Limited
(hereinafter referred to as “APCPDCL”) on 10 and 11 February 2003,

The JICA Team and APTRANSCO&APCPDCL have examined and confirmed that the
implementation plan met the S/W.

But to avoid misunderstanding, both sides have also agreed on revised Articles of the
S/W as follows:

1. Article II of S/W (OBJECTIVE OF THE STUDY)

The objective of the Study is to establish the methodology of an integrated solution
package for loss reduction of distribution network covering facility improvement,
operation & maintenance, and facility & customer management by use of GIS and to
provide technical transfer of the methodology for replication.

2. Article HTI of S/W (THE STUDY AREA)
The selected districts are Ranga Reddy and Medak District

3. Article IV of S/W (SCOPE OF THE STUDY)
1. The methodology of an integrated solution package for loss reduction of
distribution network shall be established covering the following aspects: facility
improvements, operation & maintenance, and facility & customer management by
use of GIS as detailed below.

(1) Facility Improvements
a.Survey of Distribution Facilities
b.Physical Improvement of Distribution Facilities
c. Construction Plan of Distribution Facilities

ol
e Y
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(2) Operation & Maintenance
a.Data collection
b.Data analysis
c. Recommendation

(3) Facility & Customer Management by Use of GIS
a. Introduction of Basic Module of GIS
b.Identification of Area of GIS Mapping
¢. Data Collection and Input Procedure
d.Expected Effect of GIS Mapping
¢. Method of Field Survey and Technology Transfer

2. SCADA System
a. Assessment of the Existing SCADA System
b. Study of Distribution SCADA Introduction
¢. Recommendation of Distribution SCADA System

3. Technical transfer of the above methodology shall be provided in order for the
Indian counterpart to be capable of replicating the loss reduction measures established
in the same methodology.

ANNEX : Work Schedule

e e
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MEMORANDUM
OF
SECOND SURVEY
OF
JICA DEVELOPMENT STUDY
ON
IMPROVEMENT OF POWER DISTRIBUTION SYSTEM
OF
ANDHRA PRADESH IN INDIA

AGREED UPON BETWEEN
THE JICA STUDY TEAM

AND
THE TRANSMISSION CORPORATION OF ANDHRA PRADESH LIMITED

Hyderabad, 10 March 2003

T R 1T Sl

Yoshiyuki Kudo IV, Panduramgam

Team Leader Director {Projects)

JICA Study Team Transmission Corporation of
Andhra Pradesh Ltd.
(APTRANSCO)

bp

S. Surya Prakasa Rao

Director (Commercial & Projects)
Central Power Distribution
Company of Andhra Pradesh Ltd.
(APCPDCL)

-33-



18k 3 MEFR /| AT ¥ b

1. General
This memorandum covers the activities conducted by JICA study team in the period from 10
November 2002 through 10 March 2003 in the state of Andhra Pradesh.

The minutes of meeting was signed on 11 February 2003 between APTRANSCO/APCPDCL and
JICA to confirm the implementation plan of the Scope of Work signed on 29 May 2002 between
APTRANSCO and JICA, with both sides agreeing on the revised articles of the above Scope of
Work. (See Annex-1)

At the same time, the Progress Report describing the above implementation plan was submitted in 30
copies and explained in outline by JCIA study team to APTRANSCO/APCPDCL and accepted by
APTRANSCO/APCPDCL. (See Annex-5)

It is to be noted that for the mixed load the feeder has been changed from Huda Complex to
Kamalanagar because of the length of LV line.

1I. Seminar

A seminar was held on 18 February 2003 at Hotel Amrutha Castle in Hyderabad to present the
methodology to be adopted for a study on loss reduction of distribution network by explaining in
detail the Progress Report and to make an exchange of opinions on the methodology between the
participants in the seminar and JICA study team. The participants in the seminar are listed in
Annex-2,

The seminar consisted of four sessions according to the scope of the study:(1) facility
improvements, (2) operation and maintenance, (3) facility and customer management by use of GIS
and (4) SCADA,

The methodology presented in the seminar was accepted by the participants in the seminar and
APTRANSCO/APCPDCL.

The seminar material is attached herewith as Annex-6.

III. Work Schedule
i) Selection of feeders for Case Study
The feeders for Case Study was selected between November 2002 and February 2003 as follows:

For the mixed load in Ranga Reddy: feeder Kamalanagar
For the industrial load in Ranga Reddy: feeder Kathedan No.2
For the agricultural load in Medak: feeder Malkapur

ii) Installation of electronic energy meters

This work started in first week of March to complete by the middle of March 2003 by
APCPDCL.

The total number of the meters to be installed is follows.

Meter for | Meter for | Voltmeter at | KWH meter at
outgoing  of | transformer end user pump set
the feeder

KAMAILA 33 3

NAGAR

KATHEDEN 40 8

No2

MALKAPUR 1 15 1 16

TOTAL 1 88 12 16

-34-
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iii} Meter reading

Meter reading will be conducted monthly by APCPDCL until the end of June 2003.

Reading data will be sent monthly to the JICA Team in Japan by APCPDCL using ¢-mail when
the JICA Team is staying in Japan.

iv} Case Study by JICA study team for the mixed load in Ranga Reddy
This will be conducted in May and June 2003,

v} Replication by the Indian counterpart for the industrial load in Ranga Reddy and the agricultural
load in Medak
This will be conducted in July and August 2GG3.

vi) General work schedule
For general work schedule until the submission of the Final Report, sec Annex-3.

IV. Allocation of Undertakings

Allocation of undertakings that the study team and India-side should carry out, and required
equipment and materials are mentioned in Annex—4.

-35-
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MEMORANDUM
OF
THIRD SURVEY
OF
JICA DEVELOPMENT STUDY
ON
IMPROVEMENT OF POWER DISTRIBUTION SYSTEM
OF
ANDHRA PRADESH IN INDIA

AGREED UPON BETWEEN
THE JICA STUDY TEAM
AND
TRANSMISSION CORPORATION OF ANDHRA PRADESH LIMITED

P Hyderabad, 1 June 2003

Yoshiyvuki Kudo D. Ramakrishna Rao
Team Leader Chief Engineer (DFID & APL)
JICA Study Team Transmission Corporation of

Andhra Pradesh Limited
(APTRANSCQO)
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General

This memorandum covers the activities conducted by JICA study team (the Team) in
the period from 20 May 2003 through 12 June 2003 in the state of Andhra Pradesh.

Operation and Maintenance

The Team will bring back all collected data and analyze the data in Japan. However,
there are still many data that have not been collected from both Medak and Ranga
Reddy Districts. Accordingly, APTRANSCO and APCPDCL are requested to
devote themselves more time in collecting the remaining data earnestly while the

Team stays in Japan.

Technical transfer on the data analysis will be conducted during the fourth (4™)
on-site visit to India, which is scheduled in September 2003. Counterpart personnel
of APTRANSCO and APCPDCL will collect and analyze the remaining data by
themselves.

The results of analysis will be presented by the counterparts at the workshop, which 1s
planned on the fifth (5™) on-site survey in India, which is scheduled 1n December

2003,

The data so far collected is as follows *

As of June 10, 2003

District 33KV feeder 11KV feeder LV feeder Remarks
RR(S) +(N) 58(9) 364(179) ©)

Medak 79(0) 402(36) (0)

Total 137(9) 766(215) 0)

Figures show estimated number of feeders.
{ ) mdicates number of data collected by the Team.

Distribution Line

Mr. Keiji Higasinaka, the responsible member of the Team will be in Hyderabad on
27 June 2003. His departure from Japan and amival in Hyderabad is behind
schedule due to unavoidable circumstances brought about by acquisition of data for
his analysis work.

GIS and GIS Database

The team will set up GIS equipment in six (6) offices. The team owns these
equpment during the study period and these should be kept properly while the Team
is in Japan. The team requested the counterparts to keep and manage these
equipment until fifth (5”) on-site survey in India.

-37 -
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Following is the list of equipment.

Office Equipment
APTRANSCO Eﬁ?g%gé?ﬁf{?{é ‘Slg%, MS Windows XP professional,
APTRANSCO rl\)des,s%%cg?rgf:% \SII;SS, MS Windows XP professional,
Kothapet regional office ﬁ?ké%‘-:c‘é?mm‘?{éfgi h}%p‘g:lrtlg::%slg}x{tzl I(’;’i"éiifonal,
ot egomatfi | PS8 S O M5 Mo X o
Sanga Reddy circle office 5;?%%&??}?;5{;31;%: h@gﬁ?ﬁ%ﬁ;ﬁl %;?gzsr;ional,
APCPDCL Eaess%%ic‘é?fﬁ,uﬁﬁfé ‘S§S3, MS Windows XP professional,

V. Security

In response to the request from JICA Delhi Office, the Team requested APTRANSCO
and APCPDCL to provide one policeman to accompany the Team for security when

they visit Medak District.

APTRANSCO and APCPDCL pleasantly agreed this

request and dispatched appropriate person

VL.  Counterpart training

The team requested to nominate a total of four (4) persons for counterpart training.
These personnel shall be nominated from counterparts of APTRANSCO and
APCPDCL APTRANSCO and APCPDCL agreed to nominate four (4) persons for
tramning by 17 June 2003. Counterpart training will be held 1n Japan for two (2)
weeks this coming October 2003.

VII. Schedule

The future schedule is attached herewith at Annex — 1

-38-
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MEMORANDUM
OF
THIRD SURVEY
OF
JICA DEVELOPMENT STUDY
ON
IMPROVEMENT OF POWER DISTRIBUTION SYSTEM
OF
ANDHRA PRADESH IN INDIA

AGREED UPON BETWEEN
THE JICA STUDY TEAM
AND
TRANSMISSION CORPORATION OF ANDHRA PRADESH LIMITED

Hyderabad, 6 August 2003
R 7 = WA\
v o
Keiji Higashinaka P.L.V. Vara'Prifsad  /~
Team member Chief Engineer (DFID & APL}
JICA Study Team Transmission Corporation of
Andhra Pradesh Limited

(APTRANSCO})
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General

This memorendum covers the activities conducted by JICA siudy team (the Team) in the period
from 11 July 2003 through 6 August 2003 in the state of Andhra Pradesh.

Distribution Line

The Team will bring back all coliected data and analyze the data in Japan. However measuring is
still conducting as far as the end of August. Accordingly, counterparts of APCPDCL must send

measuring data by e-mail after measuring wilt be over.

Technical transfer on the data analysis will be conducted during the fourth on-site visit to India,
which is scheduled in September 2003.

The result of the third survey is as follows :

1. Number of newly attached meters for measuring

Substation Feeder Category Meter | Meter | Volt Meter
at at meter at|at
mouth [ DTR | customer | pump
of set
: . feeder
KOTHAPET | KAMALA Domestic/Commercial 0 44 3 0
NAGAR
KATTEDAN | KATTEDAN#2 | Industrial 0 66 0 0
MALKAPUR | MALKAPUR | Agricuitural 1 15 1 16
"I TOTAL i 125 4] 16
2. Number of measuring meters
Substation Feeder Category Meter | Meter | Volt Meter | KWH
at at meter at | at meter
mouth | DTR | customer | pump | at
of set | customer
. feeder
KOTHAPET | KAMALA Domestic/Commercial 1 44 3 0 3650
' NAGAR
KATTEDAN | KATTEDAN#2 | Industrial 1 78 8 0 465
MALKAPUR | MALKAPUR | Agricultural 1 15 1 16 842
TOTAL 3] 137 12 16 4957

3. Project Schdule

See attachment

-4] -
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MEMORANDUM
OF
FOURTH SURVEY
OF
JICA DEVELOPMENT STUDY -
' ON
IMPROVEMENT OF POWER DISTRIBUTION SYSTEM
S OF
ANDHRA PRADESH IN INDIA

AGREED UPON BETWEEN
THE JICA STUDY TEAM
AND
THE TRANSMISSION CORPORATION OF ANDHRA PRADESH LIMITED

Hyderabad, 24 October 2003

T ik 1 Fpb o

Yoshiyuki Kudo K. Satyanardyana Murthy

Team Leader Chief Engineer (DFID & APL)

JICA Study Team Transmission Corporation of
Andhra Pradesh Ltd.
(APTRANSCO)

-43.



183 BEE / AEITF AN

v

General

This memorandum covers the activities of JICA study team (the Team) in the period
from 06 October 2003 through 24 October 2003 in the state of Andhra Pradesh.

The Interim Report on the study so far made was submitted in thirty (30} copies and
explaiped by the Team to APTRANSCO/APCPDCL.

Operation and Maintenance

1. The analysis of voltage at the consumer-end will be made on collection of the
necessary data.

2. Items “3.4.3 Power Flow” and “3.4.5 Daily Load Curve” will be converted into
item “3.4.3 Power Supply and Demand”,

Distribution Line
The Team have got the necessary measurement data during this survey period under
the combined effort of counterparts. Accordingly, the Team will study the

improvement plan in Japan and explain to APTRANSCO/APCPDCL at the next visit
to India.

GIS and GIS Database

The Team provided GIS manual for distribution and instructed to counterparts in three
substations bow to make distribution GIS. The counterparts couid understand basic
methodologies and created distribution GIS of other feeders by themselves. Also the
counterparts will make GIS map for all the feeders of target substation by January 2004.

The team left six GPSs and three digital cameras in three substations to continue their survey.
Number of devices is as follows.

Name of substation Digital Camera

Kothapet

1

Kattedan

1

Malkapur

1

&uu%
[£+]

The Team provided two new UPSs in Kattedan and Malkapur because the capacity of the
existing UPS was insufficient.

V.

Security

The Team requested APTRANSCO and APCPDCL to provide one policeman to
accompany the Team for security when they visit Medak District. APTRANSCO and
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APCPDCL agreed this request and dispatched appropriate person.

Counterpart Training

The advance copies of A2A3 form of the four (4) nominated persons have been
received. These documents are to be sent through official channel to JICA India

Office.
Workshop
The 2nd workshop is planed to be held in the middle of January, 2003 as follows :

- First day : General explanation at the meeting hall.
- 2nd day and after ;: Group-wise meeting as required.

Schedule

The future schedule is attached herewith at Annex — 1.
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Minutes of Meeting
for
The Development Study on the Improvement of Power Distribution System
of
Andhra Pradesh in INDIA

Agreed Upon Between
Japan International Cooperation Agency (JICA) Study Team
and
Transmission Corporation of Andhra Pradesh Limited
and
Central Power Distribution Company of Andhra Pradesh Limited

Hyderabad, 27 January 2004

T % & W

Yoshiyuki Kudo Dinesh-Kuma

Team Leader Chairman & Managing Director

JICA Study Team Central Power Distribution
Company of Andhra Pradesh Ltd.
(APCPDCL)

pra__—

J.V. Pandurangam .27 ﬁ ]9[}:
Director (Projects Construction)

Transmission Corporation of
Andhra Pradesh Ltd.
(APTRANSCO)
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Minutes of Meeting for
Development Study on the Improvement of Power Distribution System
of Andhra Pradesh in INDIA

I. General

The minutes of the meeting signed between Mr.Yoshiyuki Kudo, Team Leader of
JICA Study Team and Mr. Dinesh Kumar, CMD, APCPDCL on 27-01-2004 at 15 Hrs.
in APCPDCL in the presence of Mr. Masami Kido, Energy and Mining Development
Study Division, Mining and Industrial Development Study Department, JICA and Mr.
J.V.Pandurangam, Director (Projects Construction), APTRANSCO.

This minutes of meeting covers the activities of JICA study team (hereinafter referred
to as “the Team™) in the period from 16 January 2004 through 27 January 2004 in the
state of Andhra Pradesh.

The main objectives of this visit are (1) to present the Draft Final Report, (2) to hold
the “Seminar on the Study,” and (3) to collect and analyze data and information
necessary for preparing the Final Report,

IL The Draft Final Report
The Draft Final Report on the study so far made was submitted in thirty (30) copies
and explained by the Team to APTRANSCO/APCPDCL. The counterpart is

requested to give their comments on the DF/R, all of which is very helpful for the
Team to prepare the Final Report (F/R).

The Team requested APTRANSCO and APCPDCL to inform their comments on the
report by 12 February 2004 by e-mail or through fax so that the team can compiete
the Final Report.

Suggestion;

JICA requests APTRANSCO/ APCPDCL to utilize GIS software effectively by
updating the GIS data continuously. Further following is requested:

(1) Continuous measurement of the meters and recording of readings
(2) Works as per the O & M manual should be cartied out regularly.

ITl. Conduct of the Seminar
A seminar was held on 21% January at Hotel Taj Krishna to present the study results
and its recommendation and to make an exchange of opinions on the study results
among the participants in the seminar and the Team. The participants in the seminar

are listed in Annex-1.

IV. Reflection of the Latest Data 7“’/

Ziltjo4
L
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The Team will modify/revise the Draft Final Report based on the latest data which
was provided to the Study team by APTRANSCO/APCPDCL during the Team’s stay
in Hyderabad from 16-1-2004 to 27-1-2004.

The Final Report will be submitted to Ministry of Power, Government of India
through JICA India Office.

Transfer of the Equipment to APTRANSCO

The team handed over equipments to Indian counterparts APTRANSCO/APCPDCL
after completing their study. Number and item of equipments is as follows.

DELL Dimension 4550 Desktop 6 sets
HP DeskJet 1180c — A3 (Color) 3 sets
Canon Digital camera 3 sets
Germin GPS 6 sets
ESRI ArcView Version 8.2 6 sets
Microsoft Windows XP Professional 6 sets
Microsoft Office XP Professional 6 sets
Clip on meter 6 sets
ARUN-UPS 2 sets
Geological map for three substations 1 set
Counterpart Training

Counterpart Training will be conducted for two weeks during March 2004 in Japan.
The Team will accompany four trainees during the Counterpart Training.

by g

.49 -
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Annex — 1

List of participants
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